How to Measure Digital Baseband and IF
Signals Using Agilent Logic Analyzers with
89600 Vector Signal Analysis Software
Application Note 1559

Measure, evaluate, and troubleshoot
digital baseband and IF signals with the
Agilent 1680, 1690, 16800 and 16900
Series logic analyzers, the 89600 Series
vector signal analysis (VSA) software
(v6.1). This combination works with
all 89600 measurement software
options including the W-CDMA,
WLAN (including 802.11N HT),
OFDM, OFDMA, and flexible
demodulation options.
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Overview

If you are an RF designer, you
are probably beginning to see the
appearance of more and more
digital baseband and IF
interfaces. You need to continue
performing modulation quality
measurements on these
interfaces. If you are a digital
baseband designer, you are likely
to face constant trade-offs
between signal quality and power
consumption and battery life.
You need signal analysis
measurements to find the optimal
encoding and filtering designs.
A digital vector signal analyzer
would be the perfect tool for both
these applications.

2

This application note describes
the characteristics, setup, and
operation of a digital vector
signal analyzer (VSA) created
by combining an Agilent logic
analyzer and 89601A vector
signal analysis software. Whether
you are an RF or baseband
designer, this combination of
logic analysis with vector signal
analysis enables you to access a
robust suite of signal analysis
measurements from the same
software console, saving you
valuable time in test and debug.
If you would prefer to familiarize
yourself with the capabilities
of the hardware and software
individually before you delve into
the details of using them together,
please see Appendices A and B.

Benefits of Using Logic Analyzers and 89600 VSA Software in Combination

With the logic analyzer/89600
software combination, you use
the 1680, 1690, 16800 or 16900
Series logic analyzers to perform
basic digital timing and state
analysis on digital memory,
control, and IO buses. With
flexible voltage thresholds,
sampling depths and trigger
conditions, the logic analyzer is
a powerful and flexible digital
debug tool. For digital buses
carrying digitized baseband or IF
signal data, you can use the VSA
software to do everything from
displaying a simple spectrum to
measuring the modulation quality
of your digitally modulated
communication signal. Or, use it
to extend testing and evaluation
of GSM, W-CDMA, cdma2000
(including code domain power
or CDP measurements), WLAN,
WLAN-HT, IEEE-802.16-2004,
IEEE-802.16e OFDMA,and
Bluetooth™ signals measured
by the advanced measurement
personalities in the VSA software.
With this hardware/software
combination, you can measure
active signals or signals captured
in the logic analyzer memory. You
can use the logic analyzer alone,
or the logic analyzer/89600 VSA
combination to examine active
signals. You can easily switch
between the two products using a
convenient disconnect/restart
menu selection in the 89600
user interface.
The 89600 software can run
on a PC connected to the logic
analyzer via LAN, or it can run
directly on the built-in Windows®
XP system of the 1680, 16800 and
16900 Series logic analyzers. A
host PC running the VSA software
can also be the controlling PC for
the 1690 Series logic analyzers,

which connects to the PC via a
FireWire (IEEE 1394) connection.
The VSA software provides
hardware control, modulation
analysis, evaluation and
troubleshooting along with
complete results displays. The
controls and display of the logic
analyzer are disabled while it is
operating with the VSA software.

89600 VSA software
feature availability
When the VSA software is used
with Agilent logic analyzers,
almost all of its features and
options are available (see
Appendix B for details).
These include:
• Simultaneous display of time,
frequency (spectrum), and
modulation results
• Recording of time waveforms,
allowing you to re-analyze
signals and store them for
future comparisons
• Many multi-format flexible
digital demodulators settable
in center frequency, symbol
rate, filter type, and filter α/BT
(option AYA)
• A complete set of vector signal
analysis and modulation
analysis displays including
constellation, eye diagram,
EVM spectrum, EVM time,
error screens, multiple trace
displays, and a spectrogram
display

• A link to the Agilent ESG
series signal sources for
download and playback
of signals in the signal
capture memory
• Complete save and recall of
your signals, trace data, and
measurement screens
• Easy cut and paste to other
PC applications
The 89600 software’s swept
spectrum application is
not supported.
When the 89600 VSA software is
controlling the logic analyzer, you
can suspend the 89600 software
control of the logic analyzer
without exiting the VSA software.
You can then operate the logic
analyzer from its front panel.
Immediate restart of 89600 VSA
control of the logic analyzer
with automatic reset to the
last measurement state is
also provided.

Performance implications
When an Agilent logic analyzer
is used with the 89600
software, typical analog signal
specifications do not apply.
Because the signal is digital when
it enters the analyzer, there is no
specification of the instrument’s
dynamic range, noise floor, or
bandwidth. Dynamic range is
purely a function of the bit width
of the captured signal, and the
target device under test defines
other analog parameters.

• Flexible marker capabilities
including time gating,
integrated band power, offset
(delta), occupied bandwidth,
adjacent channel power, and
limit test markers
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How to Set Up and Use the Combined Hardware/Software

This tutorial shows you how to
use an Agilent logic analyzer with
the 89600 VSA software. You can
refer to it when you are getting
started the first time you connect
the two products.

Before you begin
For our demonstration, we will
use the 89600 VSA software and
a PC meeting the requirements
shown in tables Table 1 and
Table 2. If you are using an
Agilent 1680, 16800 or 16900
Series logic analyzer, the logic
analyzer’s built-in PC meets
the system requirements. No
measurement hardware or Device
Under Test is required because
the demonstration uses a
pre-captured signal recalled from
a logic analyzer configuration file,
with the logic analyzer’s offline
analysis capability. Note that all
software options are available
when you use the trial license for
the 89600 VSA software.

PC requirement

Desktop

Laptop

CPU

> 600 MHz Pentium®
or AMD-K6
(> 2 GHz recommended)

> 600 MHz Pentium
or AMD-K6
(>2 GHz recommended)

Empty slots
(required only if using
measurement hardware)

1 PCI-bus slot

1 CardBus type II slot

RAM

512 MB
(1 GB recommended)

512 MB
(1 GB recommended)

Video RAM

4 MB
(16 MB recommended)

4 MB
(16 MB recommended)

Hard disk space

300 MB available

300 MB available

Operating system

Microsoft Windows
2000 SP2 or
XP Professional

Microsoft Windows
2000 SP2 or
XP Professional

Additional drive

CD-ROM to load the
software; License transfer
requires 3.5 inch floppy
drive, network access or
USB memory stick

CD-ROM to load the
software; License transfer
requires 3.5 inch floppy
drive, network access or
USB memory stick

Interface support
(required only if using
measurement hardware)

LAN, FireWire, USB
or GPIB

LAN, FireWire, USB
or GPIB

Table 1. User-provided PC requirements

Software requirements
89601A version

V6.1, or higher

Option

- 200: Basic vector signal analysis
- 300: Hardware connectivity
- AYA: Flexible modulation analysis

Table 2. 89600 VSA software configuration used to analyze demonstration signal

Logic analyzer requirements
Logic analyzer
software version

V3.50, or higher

Logic analyzer hardware

PC meeting requirements from Table 1
(if no live measurements are to be made),
16900 Series modular system, or
16800 Series portable logic analyzer, or
1680 Series portable logic analyzer, or
1690 Series PC-hosted (with a host PC meeting above PC
requirements plus an IEEE 1394 FireWire host adapter)

Table 3. Logic analyzer hardware and software requirements
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How to Set Up and Use the Combined Hardware/Software (continued)

Setup procedures
This procedure is intended to
help you get started using the
89600 VSA software with an
Agilent logic analyzer to analyze
digital signals.

1. Download and install
software applications
Logic analyzer software
The Agilent logic analyzer
software application is
downloadable from
www.agilent.com/find/
16900_SW_Download.
Download and run the executable
to install.
89600 VSA software
You can order the 89600
Demonstration Software CD
from www.agilent.com/find/89600.
In the Key Library Information,
choose “Order Free 89600
Demonstration Software.”
Or, you can download the 89600
VSA software by going to
http://sa.tm.agilent.com/
89600/Software/
Either method you choose
will provide you with a 14-day
trial license.
The CD contains some extra
video demos that aren’t available
from the Internet download.
When you install the 89600
software, you may select the
“Software-Only Installation,”
even if you are using logic
analyzer hardware.
Detailed information and
explanations of the operation of
the software are available in the
89600’s on-line Help located on
the software’s toolbar.

2. Start the logic analyzer application
The logic analyzer software is
found under Start > Programs >
Agilent Logic Analyzer.
When prompted what to do, click
the “Open File” icon.

When they are used together, the
89600 VSA software retrieves data
from the logic analyzer. Before
starting VSA measurements, you
must configure the following items
on the logic analyzer:
• Bus and signal setup – select
which logic analyzer channels
are connected to I and Q, or
other baseband or IF buses
• Sampling setup – always use
“state mode” (synchronous
sampling), selecting the rising,
falling, or both edges of the
baseband bus clock
• Trigger setup – use the default
trigger (“trigger on anything”)
or select a trigger signal
indicating a start of frame
• Select real-time filtering if
your bus contains interleaved
control and data signals
In this demo the setup is done
for you in the configuration file.
See the online help in the logic
analyzer application software for
more detailed information.
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How to Set Up and Use the Combined Hardware/Software (continued)

3. Recall logic analyzer QPSK
example signal
The 89600 VSA Software CD
includes a pre-recorded QPSK
signal designed to be read by the
logic analyzer. Load this data file
into the logic analyzer software
as shown in Table 4. You should
see a waveform display like the
one shown in Figure 1. Note that
the digital I/Q buses are rendered
as chart-style waveforms that
resemble an oscilloscope display
or other analog time-domain
display. To see the individual bits
in a digital waveform display,
click the plus sign (“+”) next to
the signal label on the left side of
the screen.

Instructions

Toolbar menus

Open the file browser

File > Open…

Browse to the VSA directory
with logic analyzer information

C:\Program Files\Agilent\89600 VSA\LogicAnalyzer\

Load the QPSK signal

QPSK.ala

Table 4. Logic analyzer signal recall instructions

Figure 1. QPSK waveform in logic analyzer
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How to Set Up and Use the Combined Hardware/Software (continued)

4. Note the logic analyzer’s
configuration

Bus/Signal

Sampling
Trigger

While this data is already
properly set up and captured,
it’s useful to note how the logic
analyzer was configured to capture
this data. Open the Bus/Signal
menu by clicking the toolbar
button as shown in Figure 2.

Figure 2. Logic analyzer setup toolbar

In Figure 3, you can see how we
have captured two 16-bit parallel
buses, “I” and “Q.” “I” is the 16
channels on Pod 2, and “Q” is the
16 channels on logic analyzer
Pod 1. Setting up your channel
connections is as easy as checking
the channel boxes, even when
your bit order is non-standard.
Now open the Sampling menu
either by clicking the Sampling
tab at the top of the Bus/Signal
dialog box, or from the logic
analyzer setup toolbar, and you
will see settings similar to those
shown in Figure 4. Notice we are
using State mode (synchronous
sampling), sampling on the
“falling edge of clock 1.” Also note
the memory depth of the capture
is 32 K samples, with the trigger
positioned at the beginning of
the trace.

Figure 3. Bus/Signal menu

Figure 4. Sampling dialog box

7

How to Set Up and Use the Combined Hardware/Software (continued)

5. Start the VSA software and
configure it for logic analyzer input
First, run Start > (All) Programs >
Agilent 89600 VSA > Logic Analyzer >
IO Connections and ensure
that Agilent Logic Analyzer
(TCPIP::localhost) is selected, as
in Figure 5. If it is not already
there, select Add Instrument and
enter “localhost” as the hostname.
Next, start the VSA software. The
VSA software can be found via a
Desktop shortcut, or from Start >
(All) Programs > Agilent 89600
VSA > Vector Signal Analyzer.

Figure 5. Set logic analyzer address

Select the logic analyzer as ADC 1
by selecting Utilities > Hardware
and checking the TCPIP::localhost
checkbox, as shown in Figure 6.
You may need to clear the
“Default Configuration” and
“Simulate Hardware” checkboxes
to find the selection. Also, clear
any checked boxes on any
other tab.

Figure 6. Select TCPIP::localhost logic analyzer
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How to Set Up and Use the Combined Hardware/Software (continued)

6. Setup the digital measurement
parameters
First, preset the VSA analyzer
by clicking “File > Preset > Preset
Setup.” Set the Digital Input
parameters, as shown in Figure 7,
to measure the pre-recorded QPSK
signal. Click “Input > Digital…” to
find the input properties. Make
sure that your settings match
those shown in Figure 7.

Module Name – With this
parameter you can select which
analyzer module to collect data
from (if you have multiple
modules, or are using the “split
analyzer” feature of the logic
analyzer). If you have only one
module, the software will
automatically select it.

Bus Name – This is where you
select the matching logic analyzer
label names for the buses
carrying the I/Q, Mag/Phase, etc.

Parts – Input data can be
represented in the following forms:

• Two’s complement (signed)

• Real – this is scalar IF or
baseband data
• I and Q – I and Q are on
separate digital buses, and are
represented by two unique bus
label names in the logic analyzer
• I and Q (interleaved) – I and Q
are transmitted on a single
digital bus, on alternating clock
cycles (I then Q, I then Q, etc.)
• Q and I (interleaved) – the
same as I and Q (interleaved),
but Q comes before I

Figure 7. Input properties

Sample Rate – This is the sample
rate for I/Q values (symbol rate x
samples/symbol). In many cases
this is the same as the digital bus
clock rate, however if your digital
bus transmits in bursts or using
a serial interface, this value can
be different.

• Phase – when using polar
baseband format with a
fixed magnitude
• Mag and Phase – polar
baseband with magnitude
and phase

Sign – Digital signal data is
normally one of two formats:
• Offset binary (unsigned)

In this example the data is Two’s
Complement.
Refresh Names – It is often
necessary to switch logic analyzer
modules or to disconnect the
89601A software from the logic
analyzer. Clicking on this button
will cause the VSA software to
make a new enquiry of the logic
analyzer to determine the
available modules. These modules
will be shown under the Module
Name window.
Scale – Since digital values are
simple binary numbers, you may
wish to multiply by a scaling
factor to represent analog
voltages. This is not necessary for
signal analysis, but it changes the
scale and ranges of the numeric
measurements and displays.

• Mag and Phase (interleaved) –
polar baseband with Mag and
Phase interleaved on one bus
• Phase and Mag (interleaved) –
like Mag and Phase (interleaved)
but Phase comes first

Center – The center frequency for
digital baseband data is 0 Hz.
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How to Set Up and Use the Combined Hardware/Software (continued)

Start the VSA measurement and
view the spectrum
Click the Restart [ ] button on
the VSA software if it is not
already running. Change the span
to 100 kHz by double-clicking on
the span value at the lower
right-hand corner of the spectrum
display and type 100 kHz <OK>.
You should see something like
Figure 8. You can right-click each
display and select Auto Scale to
make the trace fit better.
Setup the demodulator
Select the Digital Demod
demodulator as shown in Table 5.
After selecting the demodulator,
you need to set its configuration
parameters. The software will do
this automatically if you select
one of the available Preset to
Default choices, or you can
configure the demodulator
manually using the Demod
Properties menu.

Figure 8. Spectrum and time domain display

Instructions

Toolbar menus

Select the demodulator

MeasSetup > Demodulator > Digital Demod

(See Figure 9 for the location of the format, filter and search tabs in the next steps.)
Preset demodulator
parameters to QPSK,
50 kHz symbol rate,
10 points/symbol

MeasSetup > Demod Properties > Format (tab) > Format >
QPSK > Symbol Rate 50 kHz > Points / Symbol 10

Set filtering parameters

Filter (tab) > Measurement filter > Root Raised Cosine >
Reference Filter > Raised Cosine > Alpha/BT > 0.35

Turn pulse search OFF

Search (tab) > Pulse Search (uncheck) > Close

Add two traces to the display

Display > Layout > Grid 2x2

Start the measurement
(if not already running)

Click the “Restart” [ ]button

Auto-scale the spectrum

Right-click the Spectrum trace and select “Y Auto Scale”

Table 5. 89600 VSA software demodulation setup
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Figure 9: 89600 VSA software digital
demodulation properties

How to Set Up and Use the Combined Hardware/Software (continued)

As you can see in Figure 10, by
default, traces A, B, and C show
displays of the composite signal.
Trace B shows the signal’s
spectrum. Note that trace D
shows the Error Summary table.
This table contains error
information for your signal.
Common error parameters,
such as error vector magnitude
(EVM) and frequency error (Freq
Err) provide quick indicators
that show you the quality of
your signal.
For details about QPSK displays,
see QPSK Signals in the 89600 VSA
software’s online Help.

Figure 10: 89600 VSA software – QPSK demodulation display

Explore the built-in VSA Tutorial
There is a great deal of built-in
measurement capability in the
VSA software, including markers,
frequency, time, and modulation
measurements. This tutorial can
teach you the full capability, and
is well worth exploring at this
point. To access the tutorial,
select Help > Tutorial… which
brings up the display shown in
Figure 11.

Figure 11. Tutorial display
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Conclusion

With the logic analyzer/89600
software combination, you use
the 1680, 1690, 16800 or 16900
Series logic analyzers to perform
basic digital timing and state
analysis on digital memory,
control, and IO buses. With
flexible voltage thresholds,
sampling depths and trigger
conditions, the logic analyzer is a
powerful and flexible digital
debug tool. For digital buses
carrying digitized baseband or IF
signal data, you can use the VSA
software to do everything from
displaying a simple spectrum to
measuring the modulation quality
of your digitally modulated
communication signal.
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With the logic analyzer/89600
VSA combination, now you can
make measurements at digital
baseband or IF portions of your
design as well as at the analog
RF portion. This allows you to
use consistent measurement
algorithms, as well as benefit
from one single user interface.
Now you can truly see changes as
the signal traverses your digital
baseband, IF, and RF portions of
your design.

Appendix A: 1680, 1690, 16800 and 16900 Series Logic Analyzer Capabilities and
Configuration Information
Logic analyzer capabilities
Agilent logic analysis systems
help you solve tough debug
problems, minimize your project
risk, and get your leading-edge
products to market faster. These
systems provide the performance
you need for making accurate,
reliable measurements. All
Agilent logic analyzers offer the
familiarity of Windows® XP Pro,
an intuitive graphical user
interface and straightforward
triggering capability – so you
spend more time on design and
debug and less time learning how
to use them.
With Agilent 1680, 1690, 16800
and 16900 Series logic analyzers
you can:
• Reliably capture digital buses
with clock rates up to 1.5 Gb/s,
sampling synchronously with
the target device’s clock,
or asynchronously for bus
timing analysis.

Agilent logic analyzers are
designed to minimize the time
required to configure your
measurements and give you
more time to debug your system.
For example, you can easily set
up triggers using several
convenient methods:
• Set triggers directly from
the waveform and listing
displays by selecting an edge
or a pattern.
• Draw a box around a
particular set of signals you
see in the waveform, and
automatically set the trigger to
that set of patterns.
• Drag and drop from a palette
of programmable trigger
macros to create an in-depth
trigger sequence in the
Advanced Trigger menu.
You can also display digital data
in bus- or analog-like chart-style
displays, for digital signal
processing applications.

And, because you can’t measure
what you can’t probe, we’ve used
innovative probing technologies
so you can access critical signals
in your designs. You can use
Agilent connectorless probes
that are easy to route in printed
circuit boards, support
single-ended and differential
signals, and create less than
0.7 pF of capacitive load. Or use
Agilent’s high-performance flying
lead probes to debug systems
where logic analyzer probing was
not incorporated in the original
board design.
Agilent logic analyzers also make
it easy for you to share your
instrument. When you install the
Windows-based logic analyzer
application software on your
remote PC, you can view
captured data offline. Or use
your PC to remotely control the
logic analyzer, then share the
instrument with your colleagues
easily by working offline.

• Automatically configure
accurate synchronous
sampling by measuring
data valid eyes on all bus
channels simultaneously.
• Use a wide variety of triggering
utilities from simple (e.g.,
a rising edge) to complex
(e.g., a 16-step sequence of
if/then events).
• Quickly render graphical
waveforms of data captures
up to 256 M in sample depth
using on-board hardware
acceleration.
• Perform fast digital pattern
searches on captured data using
the same acceleration hardware.
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Appendix A: 1680, 1690, 16800 and 16900 Series Logic Analyzer Capabilities and
Configuration Information (continued)
Logic analyzer configuration
information
The 89600 VSA software is
compatible with any of the
Agilent 1680, 1690, 16800 and
16900 Series logic analyzers. In
general, there are three main
things to select when configuring
a logic analyzer:
1. Modular mainframe (16900
Series), portable (1680 or
16800 Series), or hosted logic
(1690 Series) analyzer

The acquisition cards available
for the 16900 Series logic
analyzers range from 250 MHz
synchronous capture speed to
1.5 Gb/sec, with variable numbers
of channels per card. Typical
cards have 68 or 102 channels.
Acquisition cards have two types
of cables. The traditional 40-pin
cable is compatible with 20 years
of legacy probe adapters. The
higher performance cards employ
a 90-pin cable for improved

bandwidth. You will need to
match probe options (discussed
below) to the cabling type of the
card. Table 6 lists the current
acquisition modules with their
state speeds, channel counts, and
cabling type.
The 16740 Series, 16750 Series
and 16753/4/5/6 cards, although
now discontinued, are also
supported.

2. Acquisition cards (modular
system only)

Model

Max state
clock rate

Channels

Depth

Cable

3. Probes

16910A

450 MHz

102

Up to 32 M

40-pin

4. Analysis tools

16911A

450 MHz

68

Up to 32 M

40-pin

16950A

600 MHz

68

Up to 64 M

90-pin

16950B

667 MHz

68

Up to 64 M

90-pin

16951B

667 MHz

68

Up to 256 M

90-pin

16760A

1.5 Gb/s

34 / 17

64 M

90-pin

Modular systems are the most
flexible, with more choices for
measurement performance, and
are upgradeable in the future as
new acquisition technologies are
developed. There are four models
of modular mainframes:
1. 16901A, a 2-slot mainframe
with built-in 15 inch (38.1 cm)
color touch display
2. 16903A, a 3-slot mainframe
with built-in 12 inch (30.7 cm)
color touch display
3. 16902A, a 6-slot mainframe
with built-in 12 inch (30.7 cm)
color touch display
4. 16900A, a 6-slot mainframe
with no built-in display
The 16901A provides a low-cost
entry point into modular systems.
The two 6-slot options provide
maximum configurability.
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Table 6. Acquisition cards

Appendix A: 1680, 1690, 16800 and 16900 Series Logic Analyzer Capabilities and
Configuration Information (continued)
The 16800 Series portable logic
analyzers provide synchronous
capture up to 500 Mb/s, with
models ranging from 34 to 204
channels. Memory depths of up to
32 M are available.
The 1680 Series portable logic
analyzers provide synchronous
capture up to 200 MHz, with
models ranging from 34 to 136
channels. Memory depths of
512 K and 2 M samples are
available according to Table 8.

Model

Memory depth options*

Channels

16801A

1 M, 4 M, 16 M, 32 M

34

16802A

1 M, 4 M, 16 M, 32 M

68

16803A

1 M, 4 M, 16 M, 32 M

102

16804A

1 M, 4 M, 16 M, 32 M

136

16806A

1 M, 4 M, 16 M, 32 M

204

16821A

1 M, 4 M, 16 M, 32 M

34

16822A

1 M, 4 M, 16 M, 32 M

68

16823A

1 M, 4 M, 16 M, 32 M

102

*

The 1690 Series hosted logic
analyzers work much like the
1680 Series, with 200 MHz state
speed, variable number of
channels and memory depths.
The main difference is that you
control the logic analyzer from
your own host PC running
Windows 2000 and a FireWire
connection, rather than using
the built-in PC in the 1680, 16800
or 16900 Series. Table 9 provides
the range of options for the
1690 Series.

1 M of memory depth is provided standard. The memory depth can be increased at time of purchase or upgraded
later as your needs evolve.

Table 7. 16800 Series logic analyzers
Model

Memory depth

Channels

1680A

512 K

136

1680AD

2M

136

1681A

512 K

102

1681AD

2M

102

1682A

512 K

68

1682AD

2M

68

1683A

512 K

34

1683AD

2M

34

Table 8. 1680 Series logic analyzers
Model

Memory depth

Channels

1690A

512 K

136

1690AD

2M

136

1691A

512 K

102

1691AD

2M

102

1692A

512 K

68

1692AD

2M

68

1693A

512 K

34

1693AD

2M

34

Table 9. 1690 Series PC-hosted logic analyzers
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Appendix A: 1680, 1690, 16800 and 16900 Series Logic Analyzer Capabilities and
Configuration Information (continued)
Probes come in two types,
matching the cabling types
mentioned earlier – 40-pin and
90-pin. There are many options in
connection type:

Table 10 lists a selection of probe
model numbers:

Model

Type

Channels

SE/Diff

Cable

1. Mictor connector – while it has
drawbacks in routability and
mechanical reliability, it has
been the historical standard
logic analyzer connection.

E5383A

Flying leads

17

Single-ended

40-pin

E5404A

Pro Series
soft touch

34

Single-ended

40-pin

E5396A

Soft touch

17

Single-ended

40-pin

2. Samtec connector – this
connector is purely surfacemount, and has more ground
connections for lower loading
and improved cross-channel
isolation.

E5394A

Soft touch

34

Single-ended

40-pin

E5385A

Samtec

34

Single-ended

40-pin

E5346A

Mictor

34

Single-ended

40-pin

E5382A

Flying leads

17

Single-ended

90-pin

3. Soft touch connectorless
probing – no connector is
needed on the circuit board;
instead a pattern of pads is
placed on the board, and
spring-loaded pins make the
signal connection.

E5381A

Flying leads

17

Differential

90-pin

E5406A

Pro Series
soft touch

34

Single-ended

90-pin

E5405A

Pro Series
soft touch

17

Differential

90-pin

E5402A

Pro Series
soft touch,
low profile

34

Single-ended

90-pin

E5398A

Soft touch

17

Single-ended

90-pin

E5390A

Soft touch

34

Single-ended

90-pin

E5387A

Soft touch

17

Differential

90-pin

E5378A

Samtec

34

Single-ended

90-pin

E5379A

Samtec

17

Differential

90-pin

E5380A

Mictor

34

Single-ended

90-pin

4. Flying leads – when a circuit
board was not planned ahead
for debug (i.e., none of the
previous choices were
designed into the board), a
flying lead probe can be used
to make a solder connection to
a signal. These leads can also
connect to header pins on a
board, but this is less
convenient for a large number
of signals.

Table 10. Logic analyzer probes
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Appendix A: 1680, 1690, 16800 and 16900 Series Logic Analyzer Capabilities and
Configuration Information (continued)
Analysis tools rapidly consolidate
measurement data into displays
that provide insight into your
system's behavior.

Optional analysis packages for logic analyzers
B4655A FPGA dynamic probe for Xilinx
B4656A FPGA dynamic probe for Altera

Gain unprecedented visibility into your Xilinx or Altera FPGA’s internal activity. Make
incremental real-time measurements in seconds without stopping the FPGA, changing the
design or modifying design timing. Quickly set up the logic analyzer's signal bus naming by
leveraging work you did in your design environment. www.agilent.com/find/fpga

89601A-200 and -300 digital vector
signal analysis

Perform time-domain, spectrum, and modulation quality analysis on digital Baseband and IF
signals. Both options are required to provide hardware and software connectivity for logic
analyzers. www.agilent.com/find/dvsa

B4602A signal extractor tool

Extract and process signals from the logic analyzer data for output onto new buses/signals.
Analysis on the new buses/signals can be done within the logic analyzer or by other tools.
The tool is suited to:
• Extract I and Q data from serial data streams. The IQ data can be ported directly to the
89601A software for physical layer test and analysis
• Create algorithms for use with Agilent's N5110B Baseband Studio
• Re-multiplex high-speed A/D digital data that has been de-multiplexed onto additional logic
analyzer channels due to high state speeds
• Includes sample DigRF algorithms for synchronization of signal extraction to any pattern in
the digital stream

B4601C serial-to-parallel analysis
package

Eliminate the tedious, time-consuming, and error-prone task of sifting through thousands of
analysis package serial bits by looking at long vertical columns of captured 1’s and 0’s. The
B4601C serial-to-parallel analysis package is general-purpose software that allows easy
viewing and analysis of serial data. www.agilent.com/find/logic-sw-apps

B4606A advanced customization
environment – development and
runtime package

Tailor your logic analyzer interface with a wide range of control, analysis and display
capabilities specific to your measurement application. Create integrated dialogs, graphical
displays and analysis functions to quickly manipulate measurement data into a format that
provides additional insight and answers. www.agilent.com/find/logic-customview

B4607A advanced customization
environment – runtime package

Run the macros and graphical views created with a B4606A development package or obtain
and run a variety of commonly requested tools from Agilent and it’s partners to help customize
your measurement environment.

B4608A ASCII remote programming
interface

Remotely control a 16900-, 16800-, 1680-, or 1690-Series logic analysis system by issuing ASCII
commands. This interface is designed to be as similar as possible to the RPI on the 16700
Series logic analysis system, so that you can reuse existing programs. Requires either B4606A
or B4607A to be enabled. You can also use the B4606A to customize and add RPI commands.

B4610A data import package

Use the logic analyzer GUI to view data obtained from tools other than a logic analyzer.

B4630A MATLAB® connectivity and
analysis package

Make an easy connection to MATLAB and transfer your logic analyzer measurement data for
processing. Display the results on the logic analyzer in an XY scattergram chart.
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Appendix B 89600 VSA Software Capabilities and Configuration Information

89600 Series VSA software
capabilities
The 89600 vector signal analysis
software provides flexible tools
for making RF and modulation
quality measurements on digital
communications signals.
You can analyze a wide variety of
standard and non-standard signal
formats with the VSA software.
Standard signal presets cover
GSM, GSM (EDGE), cdmaOne,
cdma2000, W-CDMA, WLAN,
WLAN-HT, IEEE-802.16-2004,
IEEE-802.16 OFDMA, and many
more. For proprietary standards,
the 89600 VSA software series
offers numerous digital
demodulators with variable
center frequency, symbol rate,
filter type, and filter alpha/BT.
A user-adjustable adaptive
equalizer is also provided.
The VSA software lets you:
• Quickly evaluate and
troubleshoot digitally
modulated signals with the
modulation analysis tools.
• Use the constellation and
vector diagrams for an overall
indication of signal behavior
and to obtain clues to the
cause of a problem.
• Take advantage of the EVM,
EVM spectrum, and EVM
time capabilities for a more
sensitive examination of
signal errors.
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You can perform time domain
analysis using the 89601A
software RF scope capability. It is
easy to evaluate pulse shape with
the main time display, select
specific portions of a burst for
analysis with the time gating
feature, and use statistical
tools like CCDF and CDF to
characterize the noise-like
behavior of your modern
communications signal.
In addition, you can simplify the
characterization of your signal
with the FFT-based spectrum
analysis tools in the 89600 VSA
analysis software. Match your
measurement span to your signal
bandwidth, thus maximizing
analysis signal-to-noise ratio
(SNR), with the wide selection of
spans available in the software.
FFT-based resolution bandwidths
provide all the resolution you
need for frequency domain
investigations. A power spectral
density (PSD) function is useful
for estimating the level of the
noise floor when you calculate
SNR. And, a spectrogram display
is provided for monitoring the
wideband behavior of hopping
signals over time.

Appendix B 89600 VSA Software Capabilities and Configuration Information
(continued)

89600 Series VSA software
configuration information
The 89600 VSA software is
available with either a nodelocked license or a floating
license. The node-locked version
is locked to a PC, which can
either be a remote PC, or the
logic analyzer itself. The floating
license runs on a network server,
which can be the same remote
PC running the VSA software. It
is not recommended for use
running inside the logic analyzer.
For more information on these
products, see the 89600 VSA
Software Technical Overview,
literature number 5989-1679EN.

89601A Options

Vector signal analysis software, including 1-year of software
update subscription service.
Option 200 required.

89601A-200

Basic vector signal analysis software

89601A-300

Hardware connectivity (includes link to Logic Analyzers)

89601A-AYA

Flexible modulation analysis

89601A-B7N

3G modulation analysis bundle

89601A-B7T

cdma2000/1xEV-DV modulation analysis

89601A-B7U

W-CDMA/HSDPA modulation analysis

89601A-B7W

1xEV-DO modulation analysis

89601A-B7X

TD-SCDMA modulation analysis

89601A-B7R

WLAN modulation analysis

89601A-B7S

IEEE-802.16-2004 OFDM modulation analysis

89601A-B7Y

IEEE-802.16 OFDMA modulation analysis

89601A-B7Z

IEEE-802.11n MIMO modulation analysis

89601A-105

Dynamic link to EEsof/ADS
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Related Literature for logic analyzers

Product Web site

Publication Title

Publication Type

Publication Number

16900 Series Logic Analysis Systems

Brochure

5989-0420EN

16900 Series Logic Analysis Systems

Data sheet

5989-0421EN

Timing and State Modules for the 16900 Series

Data sheet

5989-0422EN

16800 Series Logic Analyzers

Brochure

5989-5062EN

16800 Series Logic Analyzers

Data sheet

5989-5063EN

B4655A FPGA Dynamic Probe for Xilinx

Data sheet

5989-0423EN

B4655A Frequently Asked Questions

Data sheet

5989-1170EN

B4656A FPGA Dynamic Probe for Altera

Data sheet

5989-5595EN

B4656A Frequently Asked Questions

Data sheet

5989-5716EN

Probing Solutions for Logic Analyzers

Brochure

5968-4632E

Related Literature for vector signal analyzers

Product Web site

Publication Title

Publication Type

Publication Number

89600S Vector Signal Analyzer

CD

5980-1989E

89600 Series Vector Signal Analysis
Software 89601A/89601AN/89601N12

Technical overview

5989-1679EN

89600 Series Vector Signal Analysis
Software 89601A/89601AN/89601N12

Data sheet

5989-1786EN

Hardware Measurement Platforms for
the Agilent 89600 Series Vector Signal
Analysis Software

Data sheet

5989-1753EN

89600 Series Vector Signal Analyzers

VXI configuration guide

5968-9350E

89650S Wideband Vector Signal Analyzer
Technical overview
System with High-Performance Spectrum Analysis

5989-0871EN

89650S Wideband Vector Signal Analyzer
Configuration guide
System with High-Performance Spectrum Analysis

5989-1435EN

89604A Distortion Test Suite Software

5988-7812EN
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Technical overview

For the most up-to-date and
complete application and product
information, please visit our
product Web site at:
www.agilent.com/find/logic
www.agilent.com/find/fpga
www.agilent.com/find/logic-sw-apps

For the most up-to-date and
complete application and product
information, please visit our
product Web site at:
www.agilent.com/find/89600

Agilent Email Updates
www.agilent.com/find/emailupdates
Get the latest information on the products
and applications you select.

Agilent Direct
www.agilent.com/find/quick
Quickly choose and use your test
equipment solutions with confidence.

Agilent
Open
www.agilent.com/find/open
Agilent Open simplifies the process of
connecting and programming test systems
to help engineers design, validate and
manufacture electronic products. Agilent
offers open connectivity for a broad range
of system-ready instruments, open industry
software, PC-standard I/O and global
support, which are combined to more easily
integrate test system development.

Remove all doubt
Our repair and calibration services will get
your equipment back to you, performing
like new, when promised. You will get full
value out of your Agilent equipment
throughout its lifetime. Your equipment
will be serviced by Agilent-trained
technicians using the latest factory
calibration procedures, automated repair
diagnostics and genuine parts. You will
always have the utmost confidence in
your measurements.
Agilent offers a wide range of additional
expert test and measurement services for
your equipment, including initial start-up
assistance onsite education and training,
as well as design, system integration,
and project management.
For more information on repair and
calibration services, go to
www.agilent.com/find/removealldoubt

www.agilent.com
For more information on Agilent
Technologies’ products, applications
or services, please contact your local
Agilent office. The complete list is
available at:
www.agilent.com/find/contactus
Phone or Fax
United States:
(tel) 800 829 4444
(fax) 800 829 4433
Canada:
(tel) 877 894 4414
(fax) 800 746 4866
China:
(tel) 800 810 0189
(fax) 800 820 2816
Europe:
(tel) 31 20 547 2111
Japan:
(tel) (81) 426 56 7832
(fax) (81) 426 56 7840

MATLAB® is a U.S. registered trademark of
The MathWorks, Inc.
Microsoft®, Windows 2000®, NT® and
XP® are U.S. registered trademarks of
Microsoft Corporation.

Korea:
(tel) (080) 769 0800
(fax) (080) 769 0900

Pentium® is a U.S. registered trademark of
Intel Corporation.

Latin America:
(tel) (305) 269 7500

Bluetooth® and the Bluetooth logos are
registered trademarks owned by Bluetooth
SIG, Inc., U.S.A. and licensed to Agilent
Technologies, Inc.

Taiwan:
(tel) 0800 047 866
(fax) 0800 286 331
Other Asia Pacific Countries:
(tel) (65) 6375 8100
(fax) (65) 6755 0042
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